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1 Introduction 

1.1 About NITRO-Player 
NITRO-Player plays and tests the NITRO-Composer sound data through the Nintendo DS (DS). 

The user can perform operations using the PC mouse and keyboard—for example, playing and 
stopping sounds. Because the actual playback is routed through the DS, the user can check how 
sounds will play once they are incorporated into a game. The NITRO-Player can also check and adjust 
sounds in real time for parameters like tempo and volume that can be changed during gameplay. 

1.2 About this Manual 
This manual covers the fundamentals of using NITRO-Player, providing easy explanations about 
frequently used features. The basic components, steps for configuration, and preparation for use of the 
NITRO-Player are explained. Examples are then used to help explain the basic procedure to use the 
NITRO-Player. 

This manual provides you with the basics of NITRO-Player. To use NITRO-Player to its full extent, you 
must be familiar with NITRO-Composer. Therefore, read the NITRO-Composer manual before using 
the NITRO-Player. 

 



NITRO-Player User's Manual 

NTR-06-0258-001-A3 8  2005 Nintendo 
Released: November 15, 2005 

2 Preparing NITRO-Player 

2.1 Composition 

2.1.1 Schematic Diagram 

NITRO-Player consists of the following components: 

Figure 2-1 NITRO-Player Schematic 

2.1.2 Software 

2.1.2.1 NITRO-Player Application 
This Windows application has operations load, play, and stop sound data. This application will be 
referred to as "NITRO-Player" unless otherwise noted. 

2.1.2.2 MCS Server 
This Windows application is essential for communication between the PC and the DS. 

2.1.2.3 NITRO-Player Nintendo DS System Program 
This sound-playing program runs on the Nintendo DS. 
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2.1.3 Hardware 

To use NITRO-Player on the Nintendo DS hardware, you must connect to a PC in one of the following 
configurations: 

� IS-NITRO-EMULATOR hardware (blue box) 

Figure 2-2 Connection with the IS-NITRO-EMULATOR Hardware (Blue Box) 

PC

USB

� A DS system connected to IS-NITRO-UIC and a DS development-use flash card 

Figure 2-3 Connection with the IS-NITRO-UIC and Nintendo DS System 

DS development
Flash Card for

PC
USB

IS-NITRO-UIC
 

However, if you plan to use the playback features on a MIDI device, then you must use these 
configurations: 

� IS-NITRO-EMULATOR hardware (blue box) and IS-NITRO-UIC MIDI (or IS-AGB-MIDI) 

Figure 2-4 Connection with the IS-NITRO-EMULATOR (Blue Box) and IS-NITRO-UIC MIDI (or IS-AGB-MIDI) 

PC USB

IS-NITRO-UIC MIDI
(or IS-AGB-MIDI)

MIDI device

MIDI
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� A DS system connected to IS-NITRO-UIC MIDI and a DS development-use flash card 

Figure 2-5 Connection with the IS-NITRO-UIC MIDI and Nintendo DS System 

Flash Card for
DS development

PC
USB

IS-NITRO-UIC MIDI

MIDI device

2.2 Setup 
NITRO-Player is included in NITRO-System. If NITRO-System is set up, NITRO-Player is ready for use. 

The following is a simple explanation of how to configure NITRO-System. If NITRO-System is already 
set up, the following operation is unnecessary. For more details, read the NITRO-System 
documentation. 

2.2.1 Extract the Package 

Decompress the NITRO-System package using a decompression tool. 

2.2.2 Set Environment Variable 

Set the environment variable NITROSYSTEM_ROOT to the absolute path for the extracted directory 
NitroSystem. Everything included in this directory is indicated by $NitroSystem.

2.3 NitroPlayer Directory 
Files associated with NITRO-Player are stored within the NitroPlayer directory. The path for the 
NitroPlayer directory is: 

$NitroSystem\tools\win\NitroPlayer 

Everything within this directory is hereafter indicated using $NitroPlayer\.
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3 Basic Operations 

3.1 Starting NITRO-Player 
There are a number of ways to start NITRO-Player, but the methods depend on the hardware 
configuration. Select the appropriate configuration based on your hardware. 

� Running IS-NITRO-EMULATOR hardware (blue box) 
� Running IS-NITRO-UIC and the Nintendo DS system 
� Running IS-NITRO-EMULATOR hardware (blue box) and IS-NITRO-UIC MIDI (or IS-AGB-MIDI) 
� Running IS-NITRO-UIC MIDI and the Nintendo DS system 

3.1.1 Running with IS-NITRO-EMULATOR Hardware (Blue Box) 

Figure 3-1 Connection with the IS-NITRO-EMULATOR Hardware (Blue Box) 

PC

USB

(1) Check that the IS-NITRO-EMULATOR hardware (blue box) is correctly connected to the PC. If 
some other applications that use the blue box are running, you must exit the application before 
starting NITRO-Player. 

(2) Start MCS Server from the PC. Click the shortcut $NitroPlayer\mcsserv_EMU. Once MCS 
Server starts, the NITRO-Player DS system program will start automatically on the DS. Wait until 
the NITRO-Player logo appears on the screen. 

(3) Start the NITRO-Player application from the PC. Execute $NitroPlayer\NitroPlayer.exe.
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3.1.2 Running with IS-NITRO-UIC and Nintendo DS System 

Figure 3-2 Connection with the IS-NITRO-UIC and Nintendo DS System 

DS development
Flash Card for

PC
USB

IS-NITRO-UIC
 

(1) In order to start NITRO-Player on a DS system, you must first write the NITRO-Player DS system 
program to a DS flash card used for development. The executable file to write is 
$NitroPlayer\nito\ARM9-TS\Release\NitroPlayer.srl.

(2) Check that the PC and the DS system are connected via IS-NITRO-UIC. If another application that 
connects to the DS system is running, you must exit the application before starting NITRO-Player. 

(3) Turn on the DS system power and start the NITRO-Player DS system program. Wait until the 
"NITRO-Player" logo appears on the screen. 

(4) Start MCS Server on the PC. Execute using the shortcut $NitroPlayer\mcsserv_UIC.
(5) Start the NITRO-Player application on the PC. Execute $NitroPlayer\NitroPlayer.exe.
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3.1.3 Running with IS-NITRO-EMULATOR Hardware (Blue Box) and IS-NITRO-UIC 
MIDI (or IS-AGB-MIDI) 

Figure 3-3 Connection with the IS-NITRO-EMULATOR (Blue Box) and IS-NITRO-UIC MIDI (or IS-AGB-MIDI) 

PC USB

IS-NITRO-UIC MIDI
(or IS-AGB-MIDI)

MIDI device

MIDI

 

(1) Check that the IS-NITRO-EMULATOR hardware (blue box) is correctly connected to the PC. If 
other applications that connect to the IS-NITRO-EMULATOR hardware (blue box) are running, you 
must exit the application before starting NITRO-Player. 

(2) Insert IS-NITRO-UIC MIDI (or IS-AGB-MIDI) into the GBA Game Pak slot of the IS-NITRO-
EMULATOR. 

(3) Start MCS Server on the PC. Execute using the shortcut $NitroPlayer\mcsserv_EMU_MIDI.
Once MCS Server starts, the NITRO-Player DS system program starts up automatically on the DS 
system. Wait until "NITRO-Player" appears on the screen. 

(4) Start the NITRO-Player application on the PC. Execute $NitroPlayer\NitroPlayer.exe.

Do not remove or insert a Game Pak into the GBA Game Pak slot of the IS-NITRO-
EMULATOR while MCS Server is running. First, make sure MCS Server has stopped. 

3.1.4 Running with IS-NITRO-UIC MIDI and the Nintendo DS System  

Figure 3-4 Connection with the IS-NITRO-UIC MIDI and Nintendo DS System 

Flash Card for
DS development

PC
USB

IS-NITRO-UIC MIDI

MIDI device

(1) In order to start up NITRO-Player on the DS System, you must first load the NITRO-Player DS 
system program to the flash card for DS development. Load the executable file 
$NitroPlayer/nito/ARM9-TS/Release/NitroPlayer.srl.

(2) Confirm that the PC and the DS system are connected via IS-NITRO-UIC MIDI. If any other 
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applications that connect to the DS are running, you must exit the application before starting 
NITRO-Player. 

(3) Turn ON the DS system power, and run the NITRO-Player DS system program. Wait until the 
“NITRO-Player” logo appears on the screen.  

(4) Start the MCS server on the PC. Run the shortcut called $NitroPlayer/mcsserv_UIC.
(5) Start the NITRO-Player application from the PC. Run $NitroPlayer/NitroPlayer.exe.

3.2 Start Screen 
If NITRO-Player has started correctly, the following window appears on the screen: 

Figure 3-5 The NITRO-Player Start Screen 

If NITRO-Player is properly connected to a Nintendo DS system, "CONNECT" appears on the right 
side of the status bar of the window as shown in Figure 3-6 Indicator.

Figure 3-6 Indicator 

If "CONNECT" does not appear, no connection has been established with the DS system. Check the 
connection for any problems. 
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"MIDI" appears on the status bar next to "CONNECT" to indicate that the real-time MIDI playback 
feature is enabled. If "MIDI" does not appear, the real-time MIDI playback feature is disabled. 

3.3 Opening Sound Data 
With NITRO-Player running, the next step is to load sound data. Open the sound data in the file 
$NitroSystem\tools\nitro\SoundPlayer\data\sound_data.sar. There are different ways 
to open the file: 

� Select [Open] from the [File] menu and then choose the file from the dialog box. 
� Drag and drop the file into the NITRO-Player window. 

A window appears when the file is opened. This window remains displayed during the conversion of the 
sound data, and then closes when conversion is completed. Once the conversion has completed 
successfully, the following window appears: 

Figure 3-7 Opened Sound Data 

The folder pane shows the data structure of the Sound Archive. Each folder icon represents a 
corresponding section. Click on the SEQ folder in the folder pane to display its contents. 
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Figure 3-8 Selected SEQ Sequence 

The contents of SEQ are displayed in the file pane. As shown in Error! Reference source not found.,
the contents of the selected folder in the folder pane appear in the content pane of the NITRO-Player 
window. In this case, the content of the SEQ folder or a list of sequence data appears in the content 
pane. The data size and information about the bank being used are also shown in the window. 

Click on other folders in the folder pane to display their contents. 

3.3.1 Sorting Items 

Click on column headers in the content pane to sort and order the content. Clicking the header twice 
will toggle the order between ascending and descending. 
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3.4 Start/Stop Sequence 
To play the sequence, select the SEQ folder. Select the sequence in the content pane, from the [Play] 
Menu click [Playback]. The requested data is transferred and played on the DS system. 

To stop the playback, from the [Play] menu select [Stop]. Select [Pause] from the [Play] menu to pause 
the sound. To resume playback, select [Pause] again. If a sequence is paused and [Playback] is 
selected, the sequence will play from the beginning. 

 

If necessary, sound data is sent from the PC to the DS system for sequence playback. Sending this data 

can result in a time delay between when [Play] is selected and actual playback begins. 

3.5 Precautions When Quitting the Application 
To quit the application, reverse the startup procedure: 

(1) Quit NITRO-Player. 
(2) Quit MCS Server. 
(3) If necessary, turn the DS system power off. 
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4 The Player Window 

4.1 What is the Player Window? 
In the main window, you can start or stop sequence playback. However, to play multiple sequences at 
once, you must use the player window. 

The player window is the small sub-window shown in Error! Reference source not found..

Figure 4-1 The Player Window 

Sequences can also be played back and stopped in this window. 

4.2 Opening the Player Window 
Each of the 16 buttons in a row on the toolbar corresponds to one player window. 

Figure 4-2 The Player List Toolbar 

Click one of these buttons to open a player window. Clicking the same button repeatedly will show and 
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hide the window. 

Sixteen player windows can be displayed at one time.  

4.3 Playback Method 
First, select the sound you want to play using the two drop-down combo boxes as shown in Error! 
Reference source not found..

Figure 4-3 The Player Window (Sound Selection) 

The Sound Type Selection combo box determines the type of playback sound. The three types of 
sound are: sequence, stream, and sequence archive. If you choose sequence archive, any sequence 
archive can be selected. The Individual Sound Selection Combo box allows you to select the sequence 
or stream to be played back.  

After selecting these settings, the sound can be played back from the player window in the same way 
that it is played from the main application window. However, if you use shortcut keys for playback, the 
sound will play in the active window. 
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5 Sequence Panel 

5.1 What Is the Sequence Panel? 
The Sequence Panel allows you to recreate most of the controls available in the game program—for 
example, mute and volume. 

To open the Sequence Panel, from the [View] menu select [Sequence Panel]. This opens the 
Sequence Panel dialog box shown in Error! Reference source not found..

Figure 5-1 The Sequence Panel 

Use the controls to change settings and see how they change while a sequence. Try moving the 
Tempo slider to hear the tempo changes in real time. 
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5.2 Explanations of Features 
This section provides information about the features in the Sequence Panel dialog box in Error! 
Reference source not found..

5.2.1 Enable Checkbox 

Deselecting the [Enable] check box disables all your configured settings and restores the default 
settings on the Sequence Panel. Selecting the [Enable] check box again re-enables your configured 
settings.. 

5.2.2 Fade in / Fade out 

Select values for [Fade-In] and [Fade-Out] to fade sound in and out when sequences begin and end. 
The unit value is one frame. 

5.2.3 Skip 

If Skip is given a value, playback starts from a designated position. The value unit is one tick. 

A greater number of skips increases the skip process and will delay the start of playback. There are 
cases where additional sounds do not play correctly during the skip process. 

5.2.4 Tempo 

The tempo of the sequence can be changed by setting a percentage value. The value 256 represents 
full tempo (100%), or no change in tempo. Click [Reset] on the right to revert to the initial value of 256. 

5.2.5 Player Volume 

Use this setting to change the player volume for the sequence. The value 127 represents full volume 
(100%), or no change in volume. Click the [Reset] button on the right to revert to the initial value of 127. 

5.2.6 Mute / Solo 

There are columns of check boxes to the left of the slider bars. The left column marked [M] stands for 
"mute" and the center column marked [S] stands for "solo." The 16 check boxes in each column 
correspond to one track.  

If the [M] check box is selected, no sound will come from that track. If the [S] check box is selected, 
sound will come from only that track. If an [S] check box is selected, any selected [M] check boxes are 
ignored. 

Pressing the [M] or [S] button toggles the check status of Mute or Solo. Click the [R] buttons at the 
bottom of each column to deselect all the check boxes in that column. 



NITRO-Player User's Manual 

NTR-06-0258-001-A3 22  2005 Nintendo 
Released: November 15, 2005 

5.2.7 Couple 

The [C] column of check boxes is used to couple tracks together. By selecting the [C] boxes for 
different tracks, changing the position for one of the track sliders will change the sliders for all of the 
selected tracks. The couple feature allows you to change parameters on multiple tracks at once. 

Pressing the [C] button toggles the check status of Couple. Click the [R] button at the bottom of this 
column to deselect all the check boxes in the column. 

5.2.8 Track Parameters 

This set of 16 slider bars are associated with the 16 tracks in the sequence. The parameters shown in 
Table 5-1 can be set separately for each track using the corresponding slider. Choose which parameter 
to set from the Volume combo box above the sliders. Table 5-1 provides more information on these 
parameters. 

Table 5-1 Meanings of the Track Parameter Values 

Parameter Meaning of the Values 

Volume Values take a range of 0 to 127, representing 0% to 100% of volume. 

Pitch Positive values raise the pitch; negative values lower the pitch. 

A value of 64 changes the pitch by a semitone. (12 semitones = 1 octave) 

Pan Positive values move pan (location) right; negative values move pan left. 

Pan = 0: sound is centered 

 +64: output only from right 

 -64: output only from left 

Once a parameter value has been changed, it remains in the state you chose. If you change the 
parameter type back, the slider holds the previously set position. Each [Reset] button to the right of the 
slider restores the settings of the current parameter to its initial value. [Reset Sliders] restores the 
currently selected parameter to the initial values for all of the tracks. [Reset All Sliders] restores all 
parameters, including the parameters that are not selected, for all of the tracks to their initial values. 

5.2.9 Pitch Range 

The [Pitch Range] value can be modified when [Pitch] is selected from the parameter drop down list. 
The [Pitch Range] determines how much you can change the pitch of a track. The initial value is 12 
and has a range of ±12 semitones. A smaller value narrows the pitch range but allows to make 
precision adjustments. A larger value increases the pitch range but affects the precise adjustments. 
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6 The Sequence Variable Panel 

6.1 What is the Sequence Variable Panel? 
Using the sequence panel allows you to reference and write the “sequence variable” variables that can 
be handled in the sequence data. 

There are two types of sequence variables: local variables and global variables. These variables are 
accessible through the Sequence Variable Panel. However, since both variables share the same dialog 
box, both are explained simultaneously.  

To open the Sequence Variable Panel, click on “Display” and select either “Sequence Variable Panel” 
or “Global Sequence Variable Panel.” The Sequence Variable Panel dialog box is shown in Figure 6-1.

Figure 6-1 The Sequence Variable Panel 

6.2 A Description of Its Features 
Each of the 16 items corresponds to one of 16 individual sequence variables. The sequences are 
numbered from 0-15.  

6.2.1 Referencing Variables 

The current value of each of the variables is displayed to the right of the combo box. For local variables, 
the variable cannot be obtained if the sequence is not playing currently. If a variable cannot be 
obtained, a hyphen (-) will be displayed. 
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6.2.2 Writing Variables 

A variable value can be written by inputting a value in the combo box and clicking “Write” in the bottom 
right corner. 

The check boxes indicate whether or not the variable will be written. Variables that are not selected will 
not be rewritten when you click “Write.” 

Clicking “X” will toggle the box state. Clicking the “R” button will clear the check boxes.  

6.2.3 Writing During Sequence Playback 

If you play back a sequence with a sequence variable panel open for a local variable, the value of the 
variables in the sequence variable panel will be written at the same time the sequence is played back. 
However, the value for the unselected check boxes will not be written. 
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7 Sound System Settings 

7.1 What are Sound System Settings? 
Sound System settings allow you to apply output effects to sounds (e.g., surround and restricting 
channels for playback). 

To configure the sound system settings, from the [View] menu select [Sound System settings]. The 
toolbar appears in the NITRO-Player window as shown in Figure 7-1 

Figure 7-1 Sound System Settings 

7.2 Output Effect 
[Output Effect] determines the type of output effect applied to sounds. Once the output effect type is 
selected from the drop down combo box, the effect is applied immediately to the sound.  

Table 7-1 Types of Output Effects 

Option Description 

Off The Output Effect feature is not used (the default setting) 

Normal Normal (stereo) mode 

Surround Surround sound mode 

Headphone Headphone mode 

Mono Mono mode 

Channels 1 and 3 are used for output effects; therefore, if you lock these channels using the feature for 

restricting voicing channels (as explained below) you cannot select any Output Effect other than "Off." 

7.3 Restricting Voicing Channels 
Channel Lock is used to check the playback while restricting voicing channels. Selected channels will 
not be used for voicing. This feature can emulate how higher-priority sounds restrict lower-priority 
sounds to hear how they sound.  
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The number above each checkbox corresponds to the channel numbers used in the DS sound circuit. 

7.4 The Hard Disk Recording Feature 
The waveform data from a DS sound output captured with sound capture can be recorded in real-time 
to a PC hard disk. However, since sound capture is used, the output effects must be set to something 
besides off in advance. 

To display the file dialog box, click “Record” on the Sound System settings toolbar. Enter a name for 
the output file. The output waveform data will be in WAV format. 

When recording is finished, a dialog box will appear displaying the recording results. If an error 
occurred, the recorded waveform data will have skips because the PC and DS communications did not 
synchronize in time to record. Refer to section 7.4.1- Avoiding Errors and re-record the data. 

7.4.1 Avoiding Errors 

Adhering to the following recommendations will help avoid errors: 

� Make the interval for obtaining data from the DS onto the MCS server as short as possible (16 ms 
is recommended). For further details, refer to the MCS Server Manual. 

� Avoid commands that load data during recording. By loading data needed for playback ahead of 
time, the frequency of errors can be reduced. 

� Avoid streaming playback. Errors are more likely to occur during streaming playback due to the 
increased communication burden between the PC and the DS. 

Avoid processes that place a greater burden on the PC during recording. Errors are more likely to 
occur because the processes on the MCS server slow down.  
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8 Heap Simulation 

8.1 What is Heap Simulation? 
Using a heap simulation feature, you can check how the state of a given heap will change when 
loading or deleting data.  

In order to perform a heap simulation, you must switch to the heap simulation mode. Data is loaded 
manually in heap simulation mode. Therefore, sequence playback will fail if the necessary data is not loaded.  

From the “Display” menu select “Heap Simulation” to go into heap simulation mode. The heap 
simulation window will open. As long as this heap simulation window is open, you are in heap 
simulation mode. Once the heap simulation window is closed, you will leave that mode.  

Figure 8-1 The Heap Simulation Window 

8.2 An Explanation of the Heap Simulation Screen 
The two large view appear in the Heap Simulation Screen. The left region shows the current heap state. 
The right region shows the data that you can select for loading.  

8.2.1 The Heap Meter 

The red, yellow, and green bar meter on the left displays how much of the overall heap is being used.  

Red indicates that the region is in use. Yellow indicates how much memory the data you want to load 
will consume when loaded. Green is the unused region of the heap.  
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8.2.2 The Heap List 

The heap list panel (left) displays the contents of the data loaded to the heap.  

The contents of the heap are displayed in the heap list by choosing the hierarchy level using the Level 
drop-down combo box. Changing the value in the “Level” drop-down combo box will allow you to view 
the contents of another hierarchy level.  

8.2.3 The Load Data List 

The load list panel (right) displays the contents of the data that will be loaded.  

The two drop-down combo boxes above this pane allow you to select what to load. Making a selection 
will display the data to be loaded in this pane. If any data has already been loaded, a 0 will appear in 
the “Load Size” column and the entry will be grayed out. 

8.3 How to Operate Heap Simulation 

8.3.1 Changing the Heap Size 

The size of the sound heap must be configured. Click “Change heap size” and a dialog box to enter the 
heap size will appear. After you enter the heap size, click “OK”.  

8.3.2 Selecting the Data to Load 

Select the data you want to load using the two combo drop-down boxes above the load data list.  

The first combo box allows you to select the type of data you want to load. You can select 
“Group,” ”Sequence,” “Bank,” “WaveArc,” or “SeqArc,” 

Individual data can be designated with the bottom combo box. 

Once you have made your selection, click “Load”. The data will load onto the heap.  

8.3.3 Hierarchy Level Operations 

The operations SaveState and LoadState can be performed on the heap. 

Click “SaveState” to save the current heap state and increase the hierarchy level by one.  

Click “LoadState” to restore the current level to its initial state. 
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8.4 Cautions During Sequence Playback 
When you are not in the heap simulation mode, the sequence playback operations are the same. 
However, if the data needed to play back a sequence is not loaded in advance, the sequence cannot 
be played back..  

If playback fails, an error message will be output to the MCS server window. For further details about 
this error message, refer to 10.1- Error Messages. 
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9 Other Features 

9.1 Convert 
Once the sound data has been updated, the data can be converted using NITRO-Player. The results of 
the conversion are immediately available on NITRO-Player. 

To convert the sound data, from the [File] menu select [Convert]. A dialog box appears during the 
conversion process , and then under normal circumstances, closes automatically when the conversion 
process ends. The content displayed in the NITRO-Player window changes to reflect the new sound 
data. You can now resume using the sound controls. 

If an error is generated during the conversion process, an error message appears including details 
about the error that occurred. To handle the conversion error, read the error message and fix the sound 
data. 

9.2 Real-time MIDI Playback 
If the PC is connected to IS-NITRO-UIC MIDI or IS-AGB-MIDI, you can perform real-time MIDI 
playback. If the hardware is properly connected, "MIDI" appears on the right side of the status bar of 
the window as shown in Figure 9-1.

Figure 9-1 MIDI Indicator 

For real-time MIDI playback, you must set the bank that will be used for playback. To do this, select the 
BANK folder in the folder pane and then select the bank from the content pane. Select [MIDI bank] 
from the [Play] menu to register the specified bank that will be used for MIDI playback. After doing 
these steps, sound can be played by sending MIDI signals to the MIDI input of IS-NITRO-UIC MIDI or 
IS-AGB-MIDI. 

9.2.1 MIDI Reset 

If you want to reset the MIDI status, select MIDI Reset from the Playback menu. MIDI reset stops notes 
generated by real-time MIDI playback and the control change is set to the default value. 
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9.3 Connecting / Disconnecting the Nintendo DS 
When Nitro-Player starts, NITRO-Player normally connects to the DS automatically; but if the 
connection fails, NITRO-Player will start in the disconnected state. To attempt a connection to the DS, 
from the [Communications] menu select [Connect]. 

9.4 Nintendo DS Operations 
Once NITRO-Player is ready for use, the DS interface can be used for playback.  

The DS controls are exactly the same as those for the NITRO-Composer SoundPlayer. For details, see 
the NITRO-Composer manual. 

However, Nintendo DS operations cannot be performed when in heap simulation mode. 
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10 Appendix 

10.1 Error Messages 
If a sequence fails to play back, an error message will appear in the MCS server window.  

Table 10-1 List of Error Messages 

Error Message Description 

Low Priority Playback is not possible because a sequence with a higher priority is 

currently playing. 

Invalid Seq No Undefined sequence number. 

Invalid SeqArc No Undefined sequence archive number. 

Invalid Bank No Undefined bank number.  

Invalid WaveArc No Undefined waveform archive number. 

Invalid Group No Undefined group number. 

Invalid SeqArc Index Undefined sequence archive index. 

Invalid Stream No Undefined stream number. 

Invalid Stream Player No Undefined stream player number. 

Memory Over Insufficient memory. No more data can be loaded.  

Too Large Data Playback is not possible because the amount of data is too large.  

Not Found Wave Data Waveform data not found. (Heap Simulation Mode) 

Not Found Bank Data Bank data not found. (Heap Simulation Mode) 

Not Found Seq Data Sequence data not found. (Heap Simulation Mode) 

Not Found SeqArc Data Sequence archive data not found. (Heap Simulation Mode) 

Not Enough Player Heap for Wave The player heap is too small to load the waveform data. 

Not Enough Player Heap for Bank The player heap is too small to load the bank data. 

Not Enough Player Heap for Seq The player heap is too small to load the sequence data. 



User's Manual NITRO-Player 

 2005 Nintendo 33 NTR-06-0258-001-A3 
Released: November 15, 2005 



NITRO-Player User's Manual 

NTR-06-0258-001-A3 34  2005 Nintendo 
Released: November 15, 2005 

Windows is a registered trademark or a trademark of Microsoft Corporation in the U.S. and other nations. 

All other mentioned company names and products names, etc. are registered trademarks or trademarks of the respective companies. 

 

© 2005 Nintendo 
The contents of this document cannot be 
duplicated, copied, reprinted, transferred, 
distributed or loaned in whole or in part without 
the prior approval of Nintendo Co. Ltd. 


	1 Introduction
	1.1 About NITRO-Player
	1.2 About this Manual

	2 Preparing NITRO-Player
	2.1 Composition
	2.1.1 Schematic Diagram
	2.1.2 Software
	2.1.2.1 NITRO-Player Application
	2.1.2.2 MCS Server
	2.1.2.3 NITRO-Player Nintendo DS System Program

	2.1.3 Hardware

	2.2 Setup
	2.2.1 Extract the Package
	2.2.2 Set Environment Variable

	2.3 NitroPlayer Directory

	3 Basic Operations
	3.1 Starting NITRO-Player
	3.1.1 Running with IS-NITRO-EMULATOR Hardware (Blue Box)
	3.1.2 Running with IS-NITRO-UIC and Nintendo DS System
	3.1.3 Running with IS-NITRO-EMULATOR Hardware (Blue Box) and IS-NITRO-UIC MIDI (or IS-AGB-MIDI)
	3.1.4 Running with IS-NITRO-UIC MIDI and the Nintendo DS System

	3.2 Start Screen
	3.3 Opening Sound Data
	3.3.1 Sorting Items

	3.4 Start/Stop Sequence
	3.5 Precautions When Quitting the Application

	4 The Player Window
	4.1 What is the Player Window?
	4.2 Opening the Player Window
	4.3 Playback Method

	5 Sequence Panel
	5.1 What Is the Sequence Panel?
	5.2 Explanations of Features
	5.2.1 Enable Checkbox
	5.2.2 Fade in / Fade out
	5.2.3 Skip
	5.2.4 Tempo
	5.2.5 Player Volume
	5.2.6 Mute / Solo
	5.2.7 Couple
	5.2.8 Track Parameters
	5.2.9 Pitch Range


	6 The Sequence Variable Panel
	6.1 What is the Sequence Variable Panel?
	6.2 A Description of Its Features
	6.2.1 Referencing Variables
	6.2.2 Writing Variables
	6.2.3 Writing During Sequence Playback


	7 Sound System Settings
	7.1 What are Sound System Settings?
	7.2 Output Effect
	7.3 Restricting Voicing Channels
	7.4 The Hard Disk Recording Feature
	7.4.1 Avoiding Errors


	8 Heap Simulation
	8.1 What is Heap Simulation?
	8.2 An Explanation of the Heap Simulation Screen
	8.2.1 The Heap Meter
	8.2.2 The Heap List
	8.2.3 The Load Data List

	8.3 How to Operate Heap Simulation
	8.3.1 Changing the Heap Size
	8.3.2 Selecting the Data to Load
	8.3.3 Hierarchy Level Operations

	8.4 Cautions During Sequence Playback

	9 Other Features
	9.1 Convert
	9.2 Real-time MIDI Playback
	9.2.1 MIDI Reset

	9.3 Connecting / Disconnecting the Nintendo DS
	9.4 Nintendo DS Operations

	10 Appendix
	10.1 Error Messages


